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Chapter 2 - Safety Information
• Read this manual carefully before using the module 13/014.
• Store the manual carefully and in a place of easy access for future reference if needed.
• Make sure that this manual is delivered to the end user.
The safety symbols used in this manual are described below:
DANGER:
This symbol indicates the possibility of serious injury to persons due to electrical or mechanical shocks.
CAUTION:
This symbol indicates the possibility of damage to objects or to the module itself.
WARNINGS:
Additional information for the correct use of the module.

✔
✔
✔
✔
✔
✔

Make sure the module power supply voltage corresponds to the data plate.
Never supply power to the module without the cover and do not remove the cover while power is present.
Do not perform manipulations on the module with wet hands. There is a danger of electrical shock.
Before you start wiring make sure there is no power supply.
Before performing any maintenance must be disconnected all power sources.
Maintenance, inspection and replacement must be performed by a designated person.

✔
✔
✔

Always clamp the module before wiring.
The installation must be performed by qualified technical personnel.
For the respect of the rules on electrical safety, make the ground connections according to the standard of
the country where the module is installed.
Install a protection circuit (fuse or magnetic circuit breaker) feeding module.
Never modify the form.
Clean the module with a vacuum cleaner. Do not use organic solvents. There is a danger of damaging the
module.
It 'important for your safety that a possible revision of the module is carried out by our company.
In case of disposing, the module is considered an industrial waste, therefore comply with the rules imposed
by the laws of the country where it is installed.

✔
✔
✔
✔
✔

The module 13/014 meets the following industry standards:
Standard/Marking

Description

CEI EN 60204-1

Safety Low Voltage Directive, 73/23/CEE.

CEI EN 61800-3

Product standard referred to the directive EMC 89/336/CEE.

CEI EN 60529

Protection level IP20.

CE

Marking CE.

ALTER Elettronica s.r.l.
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Chapter 3 - Technical features
3.1 Generality
The function of the module 13/014 is to convert the signal of a linear encoder with EnDat interface into an incremental encoder TTL
Line Driver with Hall sectors.
Encoder with EnDat 2.1 or 2.2 supported:
• Absolute linear encoders with or without incremental channels : EnDat 01, 02, 21, 22, Tx. Power supply +5Vcc with maximum resolution 32 bit (“EndatInfo.TransForm” parameter).
The module reports alarms and warnings present in the encoder and self-configures reading the encoder resolution stored within it.
Furthermore, the module provides a digital output + 24V to report faults and lock the operation of the axle or other accessories.
All controls are opto-isolated and operate at 24VDC positive logic and can be generated by: buttons, relay contacts, PLC outputs, etc.
and come from one or more points.
The digital outputs are opto-isolated, work at 24VDC positive logic and are electronically protected against overload and short circuit.
The state command and outputs is displayed with LEDs.
All settings are made with a PC connected to the USB port of the module using the software provided by ALTER, and are stored internally in the module.
The electronic circuits and the I / O connectors are on a printed circuit board placed inside a metal container to obtain the best shield ing against interference.
Alarms are stored in the module, you can be viewed via the PC and reset with a corresponding digital input.

3.2 Name plate
Explanation of the various fields of the label:
1.
2.
3.
4.
5.
6.

Manufacturer's name, address, contacts.
Supply voltage auxiliary services.
Version of firmware loaded into the module.
Serial number of the module.
Type of module.
Model of the module.

All other non-specified areas, are not used in this product.
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3.3 Technical data
•
•
•
•
•
•
•
•
•
•
•

•
•
•

Implementation for mounting on panel. IP20 protection.
Operating ambient temperature: from 0 °C to + 40 °C.
Storage temperature: -10 °C to + 70 °C
Maximum relative humidity: 95% non-condensing.
Maximum altitude: 1000 m. a.s.l.
Single-phase power supply: 85 ÷ 264VAC (47 ÷ 63Hz), 120 ÷ 370Vcc / 500mA max (protect with delayed fuses 250V / 1A).
Over-voltage protection of:
◦ Inputs and signal outputs.
◦ Service power supplies.
Service connections and signals on removable connectors
Opto-isolated logic inputs (command 15 to 30VDC / 10mA max).
Opto-isolated digital outputs (24VDC / 100mA max) protected against overload and short circuit.
Analog voltage outputs, with resolution 14 bits + sign (± 10V max. - 100Ω output resistance).
Power supply outputs for references:
◦ + 24V ± 1% - 100mA max.
◦ + 10V ± 5% - 5mA max.
◦ -10V ± 5% - 5mA max.
LED display of the logic states of digital I / O, alarms, functional module.
Diagnostics and programming with PC software (Windows), with the ability to copy the settings from the PC to the module,
and vice versa.
Malfunction indication and alarms on a digital output.

3.4 Functional scheme
The following figure shows the functional diagram of the module that represents all inputs, outputs available, with related commands
and signals, as in the standard factory configuration.
Some inputs and outputs can be modified by the customer according to their needs.

Drawing 1: Module functional diagram

ALTER Elettronica s.r.l.
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Chapter 4 - Installation
4.1 Preliminary operations
•
•
•
•
•
•
•
•
•

Check that the module has not been damaged during transportation.
Mount vertically the module, away from heat sources.
Use mounting panels in non-painted sheet grounded.
Connect to a good ground one of the ground terminals placed on the module side.
Follow the connection diagrams shown in the manual.
Use shielded cables for signal connections.
Connect ground on the carpentry or to the provided terminals both ends of the screens.
Do not use terminal blocks but only shielded connectors for the joining of shielded cable signal.
Mount suppressors (spark suppressor for a.c. / diodes for d.c.) in parallel to the coils of all contactors, relays, solenoid valves,
single phase motors, three phase motors, etc.

4.2 Power connection services (X1)
The service supply is connected to the removable connector identified with the written ACL and ACN that is located in the upper part of the module; this supply voltage can be supplied by a network with alternating current
or direct current without any particular setting.
In the case of AC mains supply voltage must be between 85 and 264Vac (frequency from 47 to 63Hz); instead in
from the DC voltage power supply network of the case must be between 120 and 370Vcc.
In both cases it is mandatory to protect the module with a pair of suitable voltage fuses used to, with a current
size retarded 1A.

4.3 Signals connections
With reference to 16 on page 22, from the top side of the module are the signals of connectors that are described in the following paragraphs.

4.3.1 Analog input connector (X2)
NAME

DESCRIPTION

+10V

Output +10Vdc ±5% - 5mA max.

-10V

Output -10Vdc ±5% - 5mA max.

A0V

0V analog. The analog 0V is connected to the module container.

AI1+

Warm pole of the analog input 1.

AI1-

Cold pole of the analog input 1.

AI2+

Warm pole of the analog input 2.

AI2-

Cold pole of the analog input 2.

AI3+

Warm pole of the analog input 3.

AI3-

Cold pole of the analog input 3.

A0V

0V analog. The analog 0V is connected to the module container.

Not used.

Not used.

Not used.

Features common to all analog inputs:
• Maximum voltage: +/- 10V between the pole + and the pole – or than A0V.
• Input resistance: 110KΩ.
• Resolution: 11 bits + sign or 15 bits + sign.
Always use good quality shielded cables and connect the two ends of the shield grounded. On the frame of the module near the connectors, the fasteners for screens are available.

6

ALTER Elettronica s.r.l.

Instruction manual 91/118 V0.1

Module 13/014

Chapter 4 - Installation

4.3.2 Analog output connector (X3)
NAME

DESCRIPTION

AO1

Analog output 1. Not used.

A0V

0V analog. The analog 0V is connected to the module box.

AO2

Analog output 2. Not used.

A0V

0V analog. The analog 0V is connected to the module box.

AO3

Analog output 3. Not used.

A0V

0V analog. The analog 0V is connected to the module box.

Features common to all analog outputs:
• Maximum voltage: +/- 10V (or 0 to 10V) between the output terminal and A0V.
• output resistance: 100Ω.
• Resolution: 14 bits + sign.
Always use good quality shielded cables and connect the two ends of the shield grounded. On the frame of the module near the connectors, the fasteners for screens are available.
NOTE: due to the 100Ω output resistance, you have to consider that you may need to adjust the analog output gain to reach the
value indicated in the 10V features. For example: if the analog output is connected to an analog input of a drive having input re sistance of 10K, it must consider that from empty to load the signal will decrease by about 1%, so we will have 9,9V instead of 10V.

4.3.3 Can Bus Connector (X4)
NAME

DESCRIPTION

TRM

Inserting the bus terminating resistor.

H

Can bus wire H.

L

Can bus wire L.

A0V

0V analog. The analog 0V is connected to the module box.

NOTE: in this module the "Can Bus" connector is not used.

4.3.4 USB connector (X5)
This connector is for connecting a USB type B cable to your PC for programming, diagnostics, parameter save. For more information
see section 5.2 on page 11.

4.3.5 EnDat encoder input connector (X6)
INPUT SIGNAL ENCODER (X6)
SIGNAL
PIN N°
+5V (encoder positive supply)
1

CONNECTION

PIN N°

ENCODER
SIGNAL
Up

0V (Supply 0V encoder)

2

0V

Channel "A" incremental signal

3

A+

Channel "A" incremental signal

4

A-

0V (shield couple A + A)

5

Channel "B" incremental signal

6

B+

Channel "B" incremental signal

7

B-

0V (shield couple B + B)

8

CLOCK+ serial interface

9

CLOCK

CLOCK- serial interface

10

CLOCK

DATA+ serial interface

17

DATA

DATA- serial interface

18

DATA

0V (cable shield) – connector housing
View from solder side of the mobile connector "D" type 25 pin female.
This connector is used to connect the encoder to the module: it is mandatory to use a shielded cable with a twisted pair conductors for
ALTER Elettronica s.r.l.
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a cleaner signal and immune to any disturbance and the shield must be grounded at both ends.

4.3.5.1 Technical characteristics of the encoder
To the module 13/014 you can connect an encoder with EnDat interface 2.1 or 2.2 of the following models:
• Absolute linear encoders with or without incremental channels: EnDat 01, 02, 21, 22, Tx. + 5Vdc power supply.
To use other models, please contact our technical office.

4.3.6 Connector emulated encoder output (X7)
EMULATED ENCODER OUTPUT (X7)
SIGNAL
PIN N°
Channel “A” line-driver 5V (Ua1)
1
Channel “A” line-driver 5V (Ua1)

2

Channel “B” line-driver 5V (Ua2)

3

Channel “B” line-driver 5V (Ua2)

4

Channel “Z” line-driver 5V (Ua0)

5

Channel “Z” line-driver 5V (Ua0)

6

0V

9

Signal “Fault” line-driver 5V (UaS)

12

Signal “Fault” line-driver 5V (UaS)

13

CONNECTION

PIN N°

CNC
SIGNAL

---------------------

0V (cable shield) – connector housing
View movable connector from solder side (Connector type “D” 15 pin female).
This connector is used to send to the CNC (or other users) the emulated encoder signal: it is identical to the signal provided by a clas sical incremental encoder TTL line driver square waves.
If necessary, you can change the setting of the resolution to reduce the maximum pulse frequency: see explanation for the configura tion in the section 5.5.1 on page 12.
Also on this connector it is recommended to use shielded cable with paired braided wires.

4.3.7 Connector signals Output frequency / direction (X8)
NAME

DESCRIPTION

F+

Frequency signal (Line Driver 5V – Direct pole)

F-

Frequency signal (Line Driver 5V – Negate pole)

D+

Direction signal (Line Driver 5V – Direct pole)

D-

Direction signal (Line Driver 5V – Negate pole)

NOTE: in this module the X8 connector is not used.

4.3.8 Digital input connector (X9)
NAME

DESCRIPTION

DI1

Digital input 1: alarm reset

DI2

Digital input 2: Command enable function "Zero Without Motion" (ZWM).

DI3

Digital input 3: not used

DI4

Digital input 4: not used

DI5

Digital input 5: not used

DI6

Digital input 6: not used

DI7

Digital input 7: not used
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DESCRIPTION

DI8

Digital input 8: not used

DI9

Digital input 9: not used

D0V

0V digital inputs.

A0V

0V analog. The analog 0V is connected to the module box.

+24V

Output power supply + 24V – 100mA max.

Supply voltage from 18Vdc to 30Vdc (nominal 24VDC). The 24VDC power can be supplied from the same module (if the total cur rent drawn by the loads connected to the outputs does not exceed 100mA): D24 connected to terminal + 24V (see paragraph 4.3.9)
and D0V with terminal A0V. If you can not use the internal power supply, you must use an external power supply.
The status of each digital input is displayed by the corresponding LED which indicates that the command is valid (see paragraph 6.1
on page 21).
Examples of the digital inputs connections:

Drawing 2: Connection of contacts to digital inputs

Drawing 3: Connecting PLC outputs to the digital inputs

4.3.9 Digital output connector (X10)
NAME

DESCRIPTION

+24V

Output power supply + 24V – 100mA max.

D24

Common to be connected to + 24V for the digital outputs.

DO1

Digital output 1: Module OK.

DO2

Digital output 2: "Encoder Initialized" signal.

DO3

Digital output 3: "Positive position" signal.

DO4

Digital output 4: "Zero emulated encoder done" signal.

DO5

Digital output 5: "Zero Without Motion Function in progress" signal.

DO6

Digital output: not used.

Supply voltage from 18Vdc to 30Vdc (nominal 24VDC). The 24VDC power supply can be provided by the module itself (if the total
current drawn by the loads connected to the outputs does not exceed 100mA): D24 connected to terminal + 24V and D0V with terminal A0V (see paragraph 4.3.8). If you can not use the internal power supply, you must use an external power supply.
Output states:
OFF = floating
ON = Connected to the + 24V power supply (D24) (signaled by the corresponding LED)
Without service supply all outputs are OFF.
Maximum current for each output 100 mA, internal voltage drop at maximum current 2V. In the event of overload or short circuit on
one or more outputs all outputs are forced OFF state permanently and the module signals the anomaly.
The status of each digital output is displayed by the corresponding LED which indicates that the output is commanded (see paragraph
6.1 on page 21).

ALTER Elettronica s.r.l.
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Examples of connections to the digital outputs:

Drawing 4: Connecting relay to the digital outputs

Drawing 5: Connecting PLC inputs to the digital outputs

4.4 Restart after an alarm
When the module enters the alarm state (DO1 = OFF and flashing red led FLT) it is not guaranteed the accuracy of
the output signals (emulated encoder), so the user has to take measures to prevent damage or danger to property or
people.
After detecting the cause of the alarm, you can reset the module with one of the ways specified in paragraph 5.11.1
on page 19.
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Chapter 5 - Commissioning
To configure the module you need to be equipped with:
1. A PC with Windows operating system.
2. One free USB port on your PC (you can also use a USB Hub).
3. A USB connection cable type B (the one used for USB printers).
4. The software to be loaded on the PC to interface to the module (provided by Alter on request).
5. The driver for the USB connection (if there is an Internet connection, this is not necessary because the module is Plug & Play
and the driver is automatically downloaded).
In the absence of any of the above points you can not configure or take a module diagnostics.
NOTE: This book does not cover the topic of software, drivers, or other problems relating to compatibility with PC supplied to the
customer. In case of need you can contact the technical department ALTER. The commissioning requires that the client PC is con figured and ready to use.

5.1 Predispositions
Before setting the parameters of the module is mandatory to follow these steps:
• Connect the cable between EnDat encoder and X6 connector as shown in section 4.3.5 on page 7.
• Connect the cable between the CNC (or other user of the simulated encoder) to the connector X7 as described in paragraph
4.3.6 on page 8.
• Provide auxiliary power to the appropriate terminals (see paragraph 4.2 on page 6).
• Will illuminate all LEDs for 3 seconds (LED test), then most will go out.
• Check that the green LED "ON" is flashing. For the moment the other LEDs do not matter.
• Connect one end of the USB cable to the X5 connector on the module and the other end to a free USB port on the PC.
• Eventually wait for the time necessary to the PC to install the drivers for the module.
• Start the programming software on the PC.

5.2 Introduction to the software on the PC
After starting the application on the PC, go to the top menu and click "File → Open Project", select the project “ 13-014_V0002_ENG.pmp”. At this point we are in front of four areas where you see different data:
1. At the top we find the "Toolbar" with various buttons to perform certain functions.
2. On the left side we find the "Project Tree" where you can select the various groups of parameters that have been brought together for simplicity, the various scopes to analyze the low-rate signals or the recorder for analyzing fast signals.
3. At the bottom we find the "Variable Watch" in which the variables are displayed with their current value in real time, the
parameters to be changed and any commands (alarm reset, save parameters, etc.).
4. In the central part we find an area that can change operation according to the context. In this part we can find:
1. "Algorithm block description" in which they appear drawings or instructions to facilitate the setting or to better clarify
the meaning of the variables listed in the "Variable Watch".
2. "Oscilloscope" where you see some variables (up to 8) displayed graphically with respect to a time base, or with respect
to another variable (Graph X-Y). Updating this variable is related to the bit-rate of the communication between PC and
module, so the variations of fast signals can not be represented.
3. "Recorder" where you see some variables (up to 8) displayed graphically with respect to a time base, or with respect to
another variable (Graph X-Y). Updating this variable is related to the speed of the faster cycle (which can be seen in the
menu "Diagnostics" parameter "Fast Cycle: Period"), so it can also represent variables that change in the order of micro
seconds.
Without going into the details of all the functions of the various menus and buttons, in the next few paragraphs will explain how to
configure the module using the software on the PC to obtain a quick start user service.

5.3 Communication port activation
•
•

•
•
•

In the top menu select “Project → Options”.
From the window that appears, select the tab “Comm” and set the following values:
◦ Direct RS232 Port: COMM_ALL.
◦ Direct RS232 Speed: 57600.
Press "OK" to save the changes.
Press the "SAVE" button on the "Toolbar" to update the project.
Press red button “STOP” in the "Toolbar" so as to clear the blue outline.
ALTER Elettronica s.r.l.
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If communication between the PC and module is done correctly, should not appear in windows alarm on the PC and in the
lower right edge should appear the written “RS232; COMx; Speed=57600”.
At this point you can continue with the other paragraphs.

5.4 How to change the values
Generally, the parameters that can be changed are highlighted with a certain color.
To change the value, proceed as follows:
• With the Windows pointer, click once on the value to be changed.
• To the right of the value it will see a gray square with a lower arrow: click once on it (see Drawing 6).
• At this point there may be two situations:
1. The value to be changed is highlighted: in this case you can write with the numeric keypad a numeric value.
2. A small window appears with the written values: in this case it is mandatory to choose between the listed values.
• After the selection, press ENTER.
• If the value is written and if they do not appear alarm messages on the lower left, then the parameter has been accepted and is
already operational.

Drawing 6: Example of value modification

5.5 Fast commissioning
First of all you must verify that the status of the front LED is as indicated in these points:
• FLT red LED is OFF.
• DO1 green LED is fixed ON.
• DO2 green LED is fixed ON.
• ON green LED is flashing.
If you do not get this result must go to the paragraph 5.11 on page 18 to detect the cause of the problem.
At this point the module is already functioning and output "encoder emulation" (connector X7) there are already signals required for
maximum resolution that allows the EnDat encoder connected.
In the event of special situations is possible to refer to the sections following.

5.5.1 Emulated encoder adaptation to CNC
It may happen that the "Encoder Emulated" signal, provided by the module 13/014, isn’t suitable to the requirements of the CNC encoder input board, for the following reasons:
1. The CNC requires a specific resolution corresponding to each count pulse:
1.1. In the "Project Tree" select "Emulated Encoder" block.
1.2. At the bottom "Variable Watch," select "Parameters.EmulEncRatio" and set the resolution reduction ratio you want. In
"StsModule.EmulEncSignalPeriod" parameter will indicate the period (in micrometers) of a simulated encoder channel that will correspond to the one set in the CNC.
2. The CNC interprets the pulses with a direction opposite to the actual:
2.1. In the "Project Tree" select the "Emulated Encoder" block.
2.2. At the bottom "Variable Watch," select "Parameters.EmulEncDir" and change from NORMAL to REVERSE.
3. The CNC requires the machine zero in a specific location:
3.1. In the "Project Tree" select "Emulated Encoder" block.
3.2. You know the exact position in mm of the zero position?
▪ YES: Select "Parameters.ZeroPosition" and write the desired value in millimeters.
▪ NO: follow these steps:
1. Move the axis to the position where you want to make the machine zero.
2. Read the value of the parameters "StsModule.PosizAsse" and "Parameters.ZeroPosition".
3.

Calculate:

ZeroPosition(new)= PosizAsse+ZeroPosition (read )

4. Select "Parameters.ZeroPosition" and write the new value just calculated in millimeters.
At the end of the above amendments it is necessary to save the changed parameters. To do this you have to scroll through the
12
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"Project Tree" and select the block "Backup/Restore parameters". In the first line highlighted GREEN to click on the right to store the
changed parameters. If further information see section 5.10 on page 16.
If you want more information about the various menus available in the programming SW, you can consult the following paragraphs.

5.6 Digital inputs setup
In the "Project Tree" select the block "Digital Input setup": here you can change the digital inputs settings and verify the current logic
state of each input.
Setup.Invert: with this parameter you can reverse the
digital input logic state associated, whereas it if the input
terminal is floating corresponds a state 0 (FALSE) instead
if it is connected to + 24Vdc the status is 1 (TRUE): This
status is displayed with its yellow LED on the front.
Value: This read-only parameter indicates the logic state
provided to the blocks connected to that input digital.

Drawing 7: digital input stage
Please remember that the digital inputs have a fixed function and can not be modified by the customer. See section 4.3.8 on page 8 to
associate the function to the digital input used.
NOTE: the yellow LEDs on the front indicate the digital input logic state BEFORE the possible sign inversion, so they indicate the
logic state of the input pin. With reference to Drawing 7, the LED will show the logical state of the point marked "DIx".

5.7 Digital outputs setup
In the "Project Tree" select the block "Digital Output setup": here you can change the digital output settings and check the current
logic state of each output.
Setup.Source: with this parameter, you can view and
change the signal source that will be used to control the
digital output.
Value: This read-only parameter indicates the logical state
of the selected source with "Setup.Source".
Setup.Invert: with this parameter you can invert the logic
state associated with the digital output, whereas it the status 0 (FALSE) keeps the floating digital output instead of
the status 1 (TRUE) controls the output to + 24V.

Drawing 8: digital output stage

NOTE: the green LEDs on the front indicate the digital output logic state AFTER any reversal in sign, so they indicate the logic
state of the output pin. With reference to Drawing 8, the LED will show the logical state of the point marked “DOx”.

5.7.1 Signal sources for digital outputs
As indicated in the previous section, you can change the signal source that will be sent to the digital output by changing the " Setup.Source" parameter. Below is a table showing the possible sources and the significance of logic to understand the function of a certain
output:
OUTPUT
DEFAULT

SOURCE
NAME

DESCRIPTION

Status
“FALSE”

Status
“TRUE”

--

False Src

The output signal is fixed to FALSE and never changes state

--

--

--

True Src

The output signal is fixed to TRUE and never changes state

--

--

--

Digital Input 1

The output signal follows the logic state of the input signal DI1

DI1 = False

DI1 = True

--

Digital Input 2

The output signal follows the logic state of the input signal DI2

DI2 = False

DI2 = True

--

Digital Input 3

The output signal follows the logic state of the input signal DI3

DI3 = False

DI3 = True

--

Digital Input 4

The output signal follows the logic state of the input signal DI4

DI4 = False

DI4 = True

--

Digital Input 5

The output signal follows the logic state of the input signal DI5

DI5 = False

DI5 = True

--

Digital Input 6

The output signal follows the logic state of the input signal DI6

DI6 = False

DI6 = True

ALTER Elettronica s.r.l.
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DESCRIPTION

Status
“FALSE”

Status
“TRUE”

--

Digital Input 7

The output signal follows the logic state of the input signal DI7

DI7 = False

DI7 = True

--

Digital Input 8

The output signal follows the logic state of the input signal DI8

DI8 = False

DI8 = True

--

Digital Input 9

The output signal follows the logic state of the input signal DI9

DI9 = False

DI9 = True

DO1

Module OK

It indicates if there are alarms in the module.

Pending alarms

Module OK

DO2

Encoder INIT

It indicates whether the encoder has been initialized.

Uninitialized

Initialized

DO3

Positive
Position

Report that the current encoder position is greater than the zero position. This output can be used by CNC to understand what is the direction of the zero searching.

Negative
position

Positive
position

DO4

Emul enc. zero

Report if the encoder is passed at least once in the zero position

Zero not done

Zero done

DO5

Funct ZWM
active

Report that the function "Zero Without Motion" is active.
See section 5.9.1 on page 16 for more information.

ZWM
not active

ZWM
active

--

TimeOut

Reports that serial communication between the module and encoder
has exceeded the maximum time.

Communication OK

TimeOut

--

Comm Fault

Report error in the serial communication between the module and
encoder. Wrong data has been received.

Communication OK

Communication error

--

Enc. Intern.
fault

Indicates the presence of alarms or warnings internal to the encoder.

No alarm

Alarm

--

Posit. Refresh
Fault

Indicates that the refresh time position has exceeded 5,2mSec

Refresh ok

Refresh error

--

Incomp.
Encoder fault

Report that the EnDat encoder connected to the module is NOT
compatible

Encoder
compatible

Encoder
not comp.

Table 1: Signal sources for digital outputs

5.8 Verification encoder functioning
In the "Project Tree" select the "EnDat" block: here you can check the operation EnDat encoder connected to connector X6, read some
information from the encoder or change the parameters, alarm codes and warnings:
• Parameters.ClockFreq: you can change the maximum frequency of the EnDat clock (in KHz). We should keep the standard
factory setting.
• StsEndat.PosizAsse: indicates the position in millimeters at the same resolution received from the encoder EnDat.
• StsEndat.Speed: indicates the axis instantaneous speed in m/min.
• StsEndat.InitOk: indicates whether the encoder has been initialized correctly.
• StsEndat.Delay: indicates the delay in nanoseconds of data transfer between the module and EnDat encoder. This value can
vary depending on the length and type of connection cable.
• StsEndat.PosRefreshPeriod: indicates the current refresh period in microseconds the encoder position. This parameter depends on the type of encoder EnDat connected (Tcal value), but in any case must not be higher than 5200 microseconds.
Besides selecting the oscilloscope "Axis Position & Speed" may result in graphical form the position and speed of the encoder.

5.8.1 Information
In the "Project Tree" select the "Information" block: here you can read some information stored in the encoder that can be useful to
understand the model, resolution, etc.
• EndatInfo.Alarms: code of current alarms in the encoder. See the table on page 20.
• EndatInfo.Warnings: code of current warnings in the encoder. See the table on page 20.
• EndatInfo.Version: version EnDat protocol.
• EndatInfo.TransForm: resolution of the absolute position in the BIT.
• EndatInfo.EncType: type of encoder.
• EndatInfo.SignalPeriod: resolution incremental signal in nanometers.
14
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• EndatInfo.MeasStep: resolution of the absolute signal in nanometers.
• EndatInfo.MaxSpeed: maximum encoder mechanical speed in m/min.
Following is a list of compatible encoder with the module 13/014:
EndatInfo.EncType
4

DESCRIPTION
Absolute linear encoder.
Table 2: List types of EnDat encoders compatible

5.9 Verification and emulated encoder settings
In the "Project Tree" select the block "Emulated Encoder": here you can check the functioning and make some adjustments to the emulated encoder that is generated on connector X7:
• Parameters.EmulEncDir: is used to reverse the counting direction of the emulated encoder relative to the direction that is
read from EnDat encoders. If when you enable the movement of the axis the CNC goes into "runaway", reverse this parameter.
• Parameters.EmulEncRatio: is used to reduce the simulated encoder resolution, compared to the EnDat encoder resolution.
The reasons that lead to reduce the resolution are the following:
1. The frequency of the emulated encoder signals is too high during the movements in "fast" and the CNC can not count
them: this is manifested as a wrong indication of the position after a fast-moving, or with an "alarm tracking error "in the
CNC.
2. The CNC requires a special resolution and you can not edit it. In this case it is possible obtain a multiple resolution of
the encoder EnDat; you can not set any resolution!
Increasing by one unit the value of this parameter will halve frequency of the signals sent to the CNC. The resolution that is
obtained is indicated in the "StsModule.EmulEncSignalPeriod" parameter. The maximum frequency of the signals on A and
B of the emulated encoder can be calculated with:

F max [ Hz ]=
•
•

•

•

•
•

•

SpeedMax [m/min]
With SpeedMax = maximum axis speed [m/min].
−6
EmulEncSignalPeriod ×10 ×60

Parameters.ZeroPosition: is used to set the zero position of the axis (in mm). This will generate the simulated encoder Z
pulse generated on connector X7 at the point indicated. The CNC will do the axis zero point at that point.
Parameters.SpeedFunctZWM: it is used to set the speed (in m/min) for the execution of "Zero Without Motion" function
(see section 5.9.1). This parameter must be set to a value greater than the maximum speed of the fast movement of the axis,
with the upper limit due to the frequency of the emulated encoder signals that the CNC is able to count. By setting this parameter equal to the maximum speed of fast moving, we made sure to not have problems.
StsModule.EmulEncSignalPeriod: means the period (in
micrometers) of an emulated encoder channel that will cor- Ua1
respond to the set in the CNC. As seen from the figure to
the side, for each period correspond 4 fronts of the two signals A and B, therefore 4 counts. So the actual resolution
in micrometers corresponds to the value indicated in the Ua2
above parameter divided by 4.
StsModule.EmulEncPosiz: indicates the position (in millimeters) as it should be displayed in the CNC, also considering the resolution reduction ratio set in "EmulEncRa- Ua0
tio" parameter. If everything works regularly you should
SignalPeriod
see the same value that you read in the "PosizAsse" parameter, ignoring the differences due to the possible reduction
Drawing 9: emulated encoder signals
of the resolution.
StsEndat.PosizAsse: indicates the position (in millimeters) received from the encoder EnDat exactly at the maximum resolution for the encoder type (see parameter "EndatInfo.MeasStep" paragraph 5.8.1).
StsModule.EmulEncZero: indicates whether the axis has already passed the zero position since the module was powered.
The possible writings are:
◦ NOT DONE: it means that the zero has not yet been made.
◦ DONE: it means that the axis has passed zero and therefore was made zero machine.
StsModule.FunctZWMactive: indicates when you are on the special function "Zero Without Motion" (see section 5.9.1).
The possible writings are:
◦ INACTIVE: means that the ZWM function is not active. This is the normal condition of use of the module.
◦ ACTIVE: means that the ZWM function is in progress: the position indicated by "StsModule.EmulEncPosiz" does not
correspond to the real axis. Maintain the function enable command (DI2) active until the end.
ALTER Elettronica s.r.l.
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•

StsModule.FunctZWMaborted: indicates if the special function "Zero Without Motion" (see section 5.9.1) was aborted due
to tripping of the safety devices.
By clicking on the oscilloscope "Comparison EnDat / Emulated Encoder" you can see a graphical comparison of the actual position
received by the encoder EnDat and position that will be sent to the CNC through emulated encoder.
NOTE: when the "Parameters.EmulEncRatio" = 1, you will see the two overlapping curves. Instead, by setting the above parame ter may be noted differences between the two curves, due to the reduction of the resolution of each other.

5.9.1 Special function "Zero Without Motion" (ZWM)
This innovative feature allows you to make the "zero axis machine" connected to the module 13/014 without really moving the axis.
The advantages of this solution are evident:
1. If the CNC is able to count the maximum frequency of the emulated encoder signals, it is possible to executing the transac tion of the AXIS ZERO at the "virtual" speed of 255 m/min!!!
2. Although the CNC has only one incremental encoder input is able to avoid the actual axis movement, then you get all the
benefits like you would for an absolute encoder input.
3. In case of blackouts of electricity to the machine during the processing, may happen to be in a "situation" in which it is im possible to move the axis (for example if the tool is located inside the work piece): with this function is no longer a problem.
In fact, the CNC will do the zero with move the part.
Before using this function we should consider that:
• The function must be enabled by a dedicated digital input (DI2) and the command must remain present throughout the machine zero "virtual" operation, otherwise the ZWM function is aborted ("FunctZWMaborted").
• During the operation of the machine zero "virtual" (that is, when the ZWM function is active), the axis must remain stationary: the module 13/014 immediately stops the function ("FunctZWMaborted") if it detects a minimum real encoder movement physically connected to the axis. All this for safety.
• This function can only be enabled if it is NOT yet made a transition on the encoder zero . In this case, you must disconnect
the power supply to the module to restore the ability to fulfill this function.
• The use of ZWM function is not required. The user can always make the machine zero in the traditional way, IE by actually
move the axis.
• The enable command of ZWM function (on DI2) it must be managed by the PLC CNC in order to ensure the safety and to
prevent it reacting the loop of the axis position. It is recommended to enable ZWM function only when the machine is in
emergency condition, then with the drives that move axes disabled; when the function is complete it can again resume normal operation.
Control logic and use the function ZWM:
1. The machine has been electrically powered and the CNC must perform the zero cycle.
2. The CNC keeps disabled the axis drives and disable its position loop.
3. The CNC controls DI2 input of the module 13/014 with a + 24V voltage to the input terminal (see section 4.3.8 on page 8)
and it keeps it until the end of the cycle. The only reason why it can be taken off the command is for emergency.
4. After 500 msec by the enable command (DI2 = +24V) the module 13/014 responds with a confirmation that the ZWM cycle
is running, controlling digital output associated with the source "Funct ZWM active" (see Table 1 on page 14) generally associated to DO5 output (see section 4.3.9 on page 9). This digital output remains to TRUE logic level for the whole duration of
the function.
5. At this point the emulated encoder signals will differ, as you can see from the "StsModule.EmulEncPosiz" parameter, but it is
a "virtual" movement: in fact the axis is not moving!
6. The emulated encoder counter reaches zero and then returns to the original position. The speed with which performs this
movement "virtual" is set from "Parameter.SpeedFunctZWM" parameter.
7. When the emulated encoder counter returns to the initial position the function is complete: the CNC can understand this condition by the logic state of the digital output associated with the source "Funct ZWM active" (see Table 1 on page 14) generally associated to DO5 output (see section 4.3.9 on page 9), which goes to logic ZERO level.
8. At this point, the CNC can remove the command input DI2 and begin normal operation.

5.10 Backup / Restore parameters
All changes that are made to the parameters remain valid until it
is lacking the power to auxiliary services; if those changes have
not been saved (stored) you will be lost and the next time you will
find the old data. This feature has the advantage that, in case of
accidental modification of one or more parameters, it is sufficient
to remove the power supply for a few seconds and then switch it
on again to return to the situation of the last backup.
In this section we will see how to store the parameters in order to
16
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find them again at the next start.
In the "Project Tree" select the block "Backup / Restore parameters" in the "Variable Watch" area will appear as parameters in Drawing 10.
Backup parameters: in 1st line we find the button to start the "backup procedure", follow these steps:
• With the mouse pointer press once on the word "press to
start."
• You will see a gray square (see Drawing 11). Press with
the mouse pointer on the square.
• Will show "START". Press with mouse pointer over.
Drawing 11: backup finished
• After a few moments in the 2nd line will show the written
"BACKUP OK" if the copy is completed correctly (see
Drawing 11); otherwise it will display "BACKUP ERROR" and in the following lines there will be Error codes. If necessary,
these codes can be communicated to ALTER to verify the malfunction.
• If the copy is finished successfully you can also turn off the module without the risk of losing the entered values.
Restore parameters: if necessary you can restore the factory settings. Of course you will lose all changes made during commissioning service. To avoid that a recovery can take place accidentally, the procedure to be carried out is more complex:
• With the mouse pointer press once on the word "NOT
ENABLED", the orange row with label "Factory data reset".
• You will see a gray square(see Drawing 12). Press with
the mouse pointer on the square.
Drawing 12: restore factory parameters
• You will see a menu with two entries: NOT ENABLED,
and ENABLED. Select "ENABLED".
• At this point you have to obtain a situation similar to the Drawing 12.
• Remove the power supply of services for a few seconds and then restore it.
• After the restart will be loaded the original parameters, but to make them definitive must overwrite those earlier, following
the "Backup parameters" procedure.
NOTE: forcing the user to follow this procedure to restore parameters, if the command does not want we made sure that previous
data is not lost. In fact, even if the user accidentally made a restore, there is still a chance to recover the mistake made: simply
NOT save the restored parameters, power cycle the module to still be the previous parameters.

5.10.1 Transfer parameters from the module to the PC
You can transfer the parameters from the module to the PC and save them to the HD storage or to restore them in the module for re placement. The following procedure will transfer all the parameters currently used in the module (IE the ones displayed in the various
menus) that may also be different from those saved in the internal memory:
1. In the programming software, click on the top menu "Tools → Flash Programming". A window divided into four areas with
the set values or buttons to push.
2. Check that in the upper part may be all set as shown below (except "address used"):

Drawing 13: Target Interface
3.

Make sure that in the lower part is all set as in the following figure:

4.

Press the button "Read Flash..." in the lower left. A window will open that displays the phase of the data download.

Drawing 14: Flash Programmer
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5.
6.

After a few moments another window will appear with a request to specify where to save the file.
It is advisable to create a "ALTER" folder in "C:" and name the data-set that can then be easily identified. In this example we
will call it "Prova_001.srec".
7. Press "Close & Save Settings" at the bottom right to close the window.
NOTE: the parameters downloaded and stored on the HD of the PC may be used only to be transferred within the same module
type with the procedure explained in the next paragraph. It is forbidden to edit the file or transfer the parameters of another product: the module notices this error and block the transfer.

5.10.2 Transferring parameters from the PC to the module
The parameters that were stored on the PC with the procedure of the preceding paragraph, may be transferred in the module with the
following points:
1. In the programming software, click on the top menu "Tools → Flash Programming". A window divided into four areas with
the set values or buttons to push.
2. Check that in the upper part may be all set as shown in Drawing 13 and in the lower part is all set as in the Drawing 14.
3. In the central part "Input File" press the right button "..." and select the file to be transferred in the module: for example we
transfer the data set stored in the preceding paragraph. You should get a situation similar to the following figure:

Drawing 15: Input file
4.
5.

Press the "Write Flash" button in the bottom middle: a window will appear showing the progress of the data transfer phase.
If the transfer is completed without errors, you will appear the message "Flash Write operation finished successfully" in the
line "Status".
6. Press "Close & Save Settings" at the bottom right to close the window.
7. New parameters are available in the module and can be verified by selecting the various menu of the "Project Tree". To make
definitive you must save them to the internal memory module by following the procedure in section 5.10 on page 16, else at
the next restart of the module will return the last parameters that had been stored internally.
NOTE: the parameters downloaded and stored on the HD of the PC may be used only to be transferred within the same module
type with the procedure explained in the next paragraph. It is forbidden to edit the file or transfer the parameters of another product: the module notices this error and block the transfer.

5.11 Module alarms
In the "Project Tree" select the "Alarms module" block: here you can see the states of all possible alarms in the module.
When the red LED "FLT" blinks or the "Module OK" output goes to level 0, it means there is an alarm present. To understand what
the cause must go to this menu you see which of these alarms has the word "ALLARME".
List of alarms and possible resolution:
ALARM

REASON

RESOLUTION

Stsmodule.TimeOutFlt

Exceeded the maximum response time of Check the connection cable, serial line connection, encoder
encoder EnDat
conditions.

Stsmodule.ComFlt

Errors of communication between the Use appropriate connection cable, have cable away from
module and encoder EnDat
noise sources, check encoder conditions.
If necessary, you can increase the "ErrCntLimit" parameter, to tolerate a greater number of communication errors
before doing the reporting.

Stsmodule.EncInternalFlt

Presence of encoder internal errors.

Stsmodule.PosRefreshError Encoder position update > 5.2 msec

Check the "Details" page to identify the fault code.
Check the connection cable, serial line connection, encoder
conditions.

Stsmodule.EncNotComp

Encoder EnDat not compatible with the Check the field "EndatInfo.EncType" and “EndatInfo.module
TransForm”: compare it with compatible encoder list in
the Table 2 on page 15.

StsDriver.AdcLim

Saturation of the A/D converter internal Verify that these signals are within the prescribed range:
to the module.
AI1, AI2, AI3.
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RESOLUTION

StsDriver.I2cFlt

Internal communication problem.

Re-start the module and check if it appears again.
Advise ALTER's technical service.

StsDriver.OutFlt

Overload on one or more digital outputs. Disconnect the wires connected to the digital outputs, and
after resetting the alarm reconnect them one by one to see
what is generating the error.
In the case of capacitive loads driven by the digital outputs,
you may need to connect the wire in series with a resistor
100Ω ½Watt.

StsDriver.SupFlt

Auxiliary power supplies out of toler- Check the power supply of the services that is in the perance.
missible range.
Select the "auxiliary power voltages" menu, verify what is
wrong and inform to manage technical service ALTER.

StsDriver.WdogFlt

Cycle time out of tolerance.

Advise ALTER's technical service.

Table 3: Module alarms
Editable parameters:
• Parameters.ErrCntLimit: [1 ÷ 255]. This parameter indicates the number of communication-error cycles (ComFlt) which
are tolerated before generating an error and lock the module (Fault). In case of complaints, poor quality cable or other problems that put the "StsModule.ComFlt" alarm you can groped to increase this value.

5.11.1 Alarm reset
After eliminating the cause which produced the alarm, you can delete the message and restore normal operation of the module. To do
this you can proceed in three different ways:
1. Remove a service power supply for a few seconds and then restore it.
2. Control the digital input 1 (DI1) with a pulse from 0V to + 24V for one second: this serves to reset from a PLC or CNC.
3. In the "Project Tree" select the block "module Alarms" and press the line where it says "CmdModule.ClrFlt"; select the word
RESET.
If the FLT LED continues to flash even after making one of the points listed above, then it means that the cause of the alarm has not
been resolved: refer to the "Module alarms" menu (see section 5.11 on page 18).
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5.11.2 Details
In the "Project Tree" select the block "Details": here you can see all of errors codes, alarms and warnings that are generated by the
module and the encoder; in this way you can identify the cause more accurately. Below the table with all possible signals:
Parameter name

Description

StsEndat.ComErr

Communication errors between the module and encoder detectable with the following codes:
0x0100: communication timeout.
0x0200: CRC error.
0x0400: Address or Mrs received error.
0x0800: error parameter received.
0x1000: fault processing Type B.
0x2000: fault processing Type A.

EndatInfo.Alarms

Alarms internally detectable encoder with the following codes:
0x0001: fault light source.
0x0002: fault signal amplifier.
0x0004: fault position value.
0x0008: power supply Over-voltage.
0x0010: power supply under-voltage.
0x0020: power supply over-current.
0x0040: battery to be replaced.

EndatInfo.Warnings

Pending alarms internally detectable encoder with the following codes:
0x0001: exceeded the maximum rotation frequency.
0x0002: exceeded maximum temperature.
0x0004: reached the limit of the source light.
0x0008: low battery.
0x0010: not reached the reference point.
Table 4: Detail Module Alarms

5.12 Diagnostics
In the "Project Tree" select the "Diagnostics" block: here are some data that may be useful to talk to the technical service of ALTER.
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6.1 LED's summary table
In the following table, the components are listed as they appear on the front of the module, starting from the edge at the top left.
NAME
DESCRIPTION
Reference
Usb

USB ongoing communication between module and PC

Paragr. 5.3 on page 11

FLT

Fault

Module in alarm condition

Paragr. 5.11 on page 18

DI1

Digital Input 1

Digital input control n°1 (Alarm reset)

Paragr. 4.3.8 on page 8

DI2

Digital Input 2

Digital input control n°2 (Command ZWM function)

Paragr. 4.3.8 on page 8

DI3

Digital Input 3

Digital input control n°3 (not used)

Paragr. 4.3.8 on page 8

DI4 Digital Input 4

Indication function ZWM aborted (flashing)

Paragr. 5.11 on page 18

DI5 Digital Input 5

Indication timeout fault (flashing)

Paragr. 5.11 on page 18

DI6 Digital Input 6

Indication communication fault (flashing)

Paragr. 5.11 on page 18

DI7 Digital Input 7

Indication encoder Internal alarm (flashing)

Paragr. 5.11 on page 18

DI8 Digital Input 8

Indication position refresh delay (flashing)

Paragr. 5.11 on page 18

DI9 Digital Input 9

Not compatible encoder indication (flashing)

Paragr. 5.11 on page 18

ALARM SIGNALS

USB

DO1

Digital Output 1

Digital output state n°1 (signal MODULE OK)

Paragr. 4.3.9 on page 9

DO2

Digital Output 2

Digital output state n°2 (signal ENCODER INITIALIZED)

Paragr. 4.3.9 on page 9

DO3

Digital Output 3

Digital output state n°3 (signal POSITIVE POSITION)

Paragr. 4.3.9 on page 9

DO4

Digital Output 4

Digital output state n°4 (signal POSITION ZERO DONE)

Paragr. 4.3.9 on page 9

DO5

Digital Output 5

Digital output state n°5 (signal FUNCTION ZWM ACTIVE)

Paragr. 4.3.9 on page 9

DO6

Digital Output 6

Digital output state n°6 (not used)

Paragr. 4.3.9 on page 9

ON

Module ON

Powered and running Module (flashing).

Paragr. 5.1 on page 11
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Drawing 16: dimensions (mm)
Mass: 0,8 Kg
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